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Training Agenda
CADE Training

By the end of this training you will 
understand how to:

• Create cost reports using cPet

• Log in to the Submit-Review 
Application 

• Submit CCDR, FlexFile and Quantity 
Data Reports, 1921-3, SRDR, and CWBS 
dictionaries

• View Approved CSDR Plans in the 
CSDR-SR



COST ASSESSMENT DATA ENTERPRISECOST ASSESSMENT DATA ENTERPRISE

Getting Started With CADE



4

Requesting a CADE Portal Account 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• From the CADE Home page 

(https://cade.osd.mil/) select 

the “Request CADE Account” 

link. 

• If you already have a CADE 

Portal account, you do not 

need to register for a new 

account. 

• Please contact 

CADESupport@tecolote.com

for assistance. 



Account Registration
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Account Registration
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Create a username and password, enter your 
email address, and click submit.

• When completing the account request form, 
please request the CSDR-SR Submitter role.

• Click Submit to begin account approval. process
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Integrated User Dashboard
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Once successfully logged in, you now have the capability to customize your dashboard with 
status updates and submission information from all of the applications available to you.

News about future design releases, 
training classes, new policies and 
site maintenance will appear as a 
default tile. 

The Dashboard Help Menu explains 
how to add, modify and delete the 
different tiles of information.

Select the        icon to 
expand the list of 
dashboard tiles. 
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Integrated User Dashboard
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• You can select to display upcoming reporting requirements and current submissions in progress.
• You can also select to begin the submission process via the Upload link or select to See in CSDR to be 

taken to your Upload Home screen.
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Preparing CSDR Reports for Submission
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The Cost Planning and Execution Tool (cPet) 
allows you to create, edit and validate your cost 
reports for submission.

• Key cPet Functions

• Build & Edit CSDR Plans and RDT

• Build, Edit, & Pre-validate CCDR Formats

• Import and create Excel CCDR 

forms/templates

• Import CCDR data from Excel “flat-file”

• Export SRDR Dev/Maint Templates

• cPet native file format is XML!
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• cPet is a desktop tool that can be downloaded 
from the Tools page on the CADE public website.

• Sample files, user guides and download 
instructions can also be found on the CADE 
public website.

https://cade.osd.mil/tools/csdr-tools
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• To start a new file, select File > Import 
DD 2794 (Contract/Subcontract Plan)…

• Upload the approved excel version of 
the DD 2794 CSDR Plan.

• cPet automatically validates and 
creates an XML version of any 
document you upload. Conversion 
results will display separately in the 
document import validation window .

The approved CSDR plan can be 
found on the Submission Detail 
page in the CSDR-SR.
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Once a DD2794 CSDR Plan has been imported cPet
offers a number of tools to assist with the 
submission process 

• cPet Desktop can be used to 
• Create and Export of RDT, CWBS, Flat 

File, and SRDR Templates. 
• Creation and conversion of FlexFile 

and Quantity Data Report templates
• FlexFile & Quantity Data Report 

Validation
• For More information on using cPet

Desktop consult the cPet Desktop 
User Guide. 

https://cade.osd.mil/content/cade/files/csdr/cPet/cPet%20User%20Guide_v2.7.0_20190918.pdf
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Select New > New 1921
• A new screen will appear where you can input 

required metadata information and any needed 
remarks.

• After entering the metadata information, select 
the Save icon to save an XML version of your 
working file. You can then close the window.
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Your new 1921 file now appears on the cPet Home page.

• Use the ribbon on this screen to finish creating your 1921 file.

• The         icon will allow you to make changes to the report metadata.

• The         icon allows you to input your recurring and non-recurring financial data. 
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The       icon will allow you to enter your recurring and non-recurring data for To 
Date and At Completion costs.

• Because you imported the approved CSDR plan at the beginning of the creation 
process, cPet automatically pulls in the correct WBS from the plan. 

Select to 
save when 
complete
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• cPet will save changes to the XML version of your working file. 
• You can also select to create an Excel version of your file by selecting the “Export this cost report as a DD 

form” icon.
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Creating Cost Reports Using cPet
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• To create a 1921-1 report, Select File > New> New 1921-1.
• Follow the same steps as you did creating the 1921 report in order to 

fill in the metadata information and cost data, then save the file.
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Generating FlexFile/Q-Data Report Templates from a 
DD2794 – CSDR Plan – Step 1

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Access the FlexFile Conversion Tool
• In order to create the FlexFile Excel templates, the user must access the FlexFile Conversion Tool
• Click Tools > Convert FlexFile
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Generating FlexFile/Q-Data Report Templates from a 
DD2794 – CSDR Plan – Step 2 

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Access the FlexFile Conversion Tool
• The user has the option to generate the FlexFile JSON File using on of two Excel template options -

Multi-Part Excel Template:
• Breaks the required format tables into three parts:

1. FlexFile Template Part 1 – Metadata & Structures
2. FlexFile Template Part 2 – Actual Cost-Hour Data
3. FlexFile Template Part 3 – Supplemental Data

• Allows for one-time creation of Part I & III for initial 
submission, with updates to part II, only for subsequent 
submissions

• Breaks the format validations errors into smaller, 
manageable reports 

Excel Template:
• Includes ALL required tables in one Excel File
• Version control narrowed down to a single file
• Format error reporting extended to all tables 

1 2

1 2
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Generating FlexFile/Q-Data Report Templates from a 
DD2794 – CSDR Plan – Step 3 

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Begin by creating the FlexFile Template:

• The User Can create a Multi-Part Excel 
Template from the approved CSDR 
(DD2794) XML Plan which will generate the 
following templates in Excel:

1. FlexFile Template Part 1 – Metadata & Structures
2. FlexFile Template Part 2 – Actual Cost-Hour Data
3. Flexfile Template Part 3 – Supplemental Data 

• To create, click Tools> Convert FlexFile > Select FF 
Excel Template Format (Multi-Part or Excel 
Template) > Create

• cPet will save the Excel templates to the original file 
where the user retrieved the DD2794 source file.   
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FlexFile/Quantity Report Excel template to JSON File 
Format Conversion 

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Once the Multi-Part/Excel FlexFile & 
Quantity Report template is complete, the 
user can now import the completed 
template to generate the FlexFile/Quantity 
Import Error Log

• Tools > Convert FlexFile/Convert Quantity 
Report > Browse > Select File & Upload > 
Import

• cPet will generate an excel report to show 
where the imported file does not adhere to 
the DEI/FFS

• This report will be located in the source 
folder where the templates are stored on 
the user’s hard drive.

A JSON file will not generate unless the files are compliant with the DEI/FFS
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FlexFile/Quantity Report Excel Validation: Excel to 
JSON File Format Conversion part 2, Error Reporting

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The format validation error report 
will generate an Import Error Log by 
error type, as defined in the Date 
Exchange Instructions (DEI) and File 
Format Specification (FFS)

• The error report will identify the 
error type, as well as the table and 
cell where the error exists

• The user must correct all identified 
errors listed by type across the 
identified tables and cells

• When all errors identified by the 
single error type, the user must re-
upload the excel templates to 
generate the next error type

• The user should repeat this process 
until cPet does not identify any 
additional errors

*See next slide for an entire list of 
DEI/FFS errors
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Excel to JSON File Format Conversion part 2, FlexFile
FFS Errors

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 
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FlexFile Excel to JSON File Format Creation
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Once all identified errors have been addressed, the Excel templates must be re-imported into the conversion tool via Tools 
> Convert FlexFile > Select Multi-Part Excel Template/Excel Template > Select File & Upload > Import

• cPet will generate a zipped JSON File that adheres to the DEI/FFS and can be ingested into CADE
• The JSON Zipped File will auto-generate within the same source folder used to upload the Excel templates, which will be 

the official submission file
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XML Conversion



26

You’re Already Doing It
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

cPet defines XML standard for CCDR data



27

cPet Desktop Conversion
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Import Excel version of 
the Contract Plan, then 
the Excel 1921, 1921-1, 
and 1921-2, or Excel Flat 
File.

• cPet automatically 
creates XML versions of 
the original Excel files in 
their source folder 
directory.
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cPet Web Conversion: Legacy Files
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

1

2

3

• Navigate to cPet Web 
from the Portal Home 
Page, then select Other 
cPet Functions.

• Select Convert Excel Files 
to XML.

• Browse and select the 
Excel 1921, 1921-1, and 
1921-2 reports.  Then 
click Convert.
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cPet Web Conversion
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

You will be prompted to open a folder containing the original Excel files, as 
well as the converted XML files.
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cPet Web Conversion: FlexFiles (Single-File)
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

1

2

3

• Navigate to cPet Web from 
the Portal Home Page, 
then select Other cPet
Functions.

• Select FlexFile Excel 
Template to FlexFile (JSON)

• Browse and select the 
FlexFile Then click Import.

• A notification will appear 
directing you to the 
Retrieve Files page. 
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cPet Web Conversion: FlexFiles (Multi-Part)
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Navigate to cPet Web from 
the Portal Home Page, 
then select Other cPet
Functions.

• Select FlexFile Excel 
Template (Multi-Part) to 
FlexFile (JSON)

• Browse and select the FF-
Part 1, FF-Part 2, and FF-
Part 3.  Then click Import.

• A notification will appear at 
the top-left of the page, 
click on Retrieve Files to 
download the converted 
FlexFiles
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cPet Web Conversion: Retrieving Converted 
FlexFiles

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Note: It may take a few minutes 
for the FlexFile conversion to 
finish, click Refresh Status of 
Files to check on conversion 
status. 

• Click the           icon to 
download the imported 
FlexFile.

• Retrieve the zipped FlexFile 
from your downloads folder. 

Note: FlexFile and Quantity files 
must be uploaded in the .zip 
format. 
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Visual Validation Files
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Only the first 1921-1 and 1921-2 
report will have the header 
information highlighted in GREEN

cPet desktop and cPet Web create Excel “Visual 
Validation” files in the source folder containing 
the original files

Cells highlighted in GREEN
verify that the Excel data 
was transferred correctly to 
XML, and the data will be 
readable in XML format
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Troubleshooting
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

If the “Visual Validation” 
files contain cells that are 
not highlighted in 
GREEN, the files can be 
corrected within cPet
Desktop.

Edit and Save Header Information Edit and Save Cost Data
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SRDRs – Excel to XML Conversion: cPet Desktop 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

To Convert a SRDR Template from the excel format to the xml format using cPet desktop:
• Import your DD2794 CSDR Plan
• Once Imported, Right-Click the CSDR Plan and select Import SRDR DEV, SRDR MX, or SRDR ERP

Once selected, the cPet Document Import Validation Window Will Open 
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SRDRs – Excel to XML Conversion: cPet Document Import Validation 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The cPet Document Import Validation screen will provide information on any DEI/FFS errors that may be present 
in your SRDR Submission  

Error 
LocationError 

Description

The user can also select the     icon to export the validation data.
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SRDRs – Excel to XML Conversion: cPet Visual Conversion File
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

cPet Desktop will also create a Visual Conversion Version of you SRDR submission
• Successfully ingested data will be highlighted in green, any errors will be highlighted in orange
• cPet Desktop will automatically save the visual conversion file in the same folder as your SRDR Submission

Ingestion 
Errors will be 
highlighted 
in orange
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SRDRs – Excel to XML Conversion: XML file location
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Use the cPet Document Import Validation Screen to Identify and Correct any DEI/FFS errors present in your submission
• Once a submission is completely error free every SRDR Tab will have the          icon 

cPet Desktop will create a 
XML version of the SRDR 
in the same folder as the 
original excel file
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SRDRs – Submission vs DD2794 CSDR Plan Validation
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

To validate an SRDR 
Submission against its 
DD2794 CSDR Plan:
• Import the CSDR Plan and 

SRDR Submission as indicated 
in the xml conversion 
instructions

• Right Click the SRDR 
Submission and select 
Validate,
• cPet Desktop 

Document Validation 
Window will open

• Use the cPet Document 
Validation report to 
correct validation 
errors 



Submitting Cost Reports
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Step 1: Select Submission Event
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Access the CSDR Submit-Review Application via the CADE Portal Home Page, 
then navigate to Upload Home.
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Upload Home: Contract Request
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• In order to see all of the submission events requiring submission on your Upload Home page, you 
must first be added to the contract.

• Select the Contract Request tab and enter the Prime Contract Number or CSDR Plan Number to request 
access. 

• Clicking Send Request will alert the DCARC Validation Analyst that you need to be added to the 
contract.
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Upload Home: Assigned Contracts
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The Assigned Contracts tab shows the Submitter which contracts they are assigned 
to in the Submit-Review website.

• If a contract that you are required to submit reports for is not listed here, click on 
the Contract Request tab.

Click on the Prime 
Contract Number for more 
information about the 
contract, approved plans, 
and submission events.
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Upload Home: Submissions in Progress
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The Submissions in Progress tab displays the submissions that have either been 
started, but not submitted, or submissions that have been set back to In 
Process: Contractor by the DCARC Validation Analyst.

Select Upload to continue a 
submission.
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Upload Home: Rejected Submissions
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The Rejected Submissions tab displays a record of the submissions that have been formally 
rejected by the Director of the DCARC.
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Upload Home: Submission History
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The Submission History tab 
displays a historical record of all 
submissions, in all stages, for the 
history of the Submitter.

Select the Submission ID to 
see the details of the 
historical submission.

1

2
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Step 1: Select Submission Event
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Identify the Submission Event and click Upload to begin the submission.
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Step 2: Enter the As of Date
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Enter the report As of Date for 
the submission. The report As Of 
Date should be consistent with 
item 14d of the approved CSDR 
Plan.

• Once the POC Information has 
been verified, select Next to 
continue.
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Step 3: Browse, Select, Upload Files
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• To upload the Excel and 
XML cost report files, 
select Browse to locate 
the report, select the 
correct File Type, and 
click Upload.

• Click Next to continue.
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Step 3: Browse, Select, Upload Files
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• All sets of 1921 data will be required to be validated against the 
approved CSDR Plan prior to finalizing the submission.

• If you are required to submit multiple variants or lots, use the File 
Comment field while uploading to distinguish the different reports.

• Reporting requirements are outlined in the approved CSDR plan and 
Contract Data Requirement List (CDRL) for the contract.
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Step 4: Name Data Set & Validate
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Submitters must validate and generate a CCDR 
Data Report prior to submitting reports.

• If the submission event requires multiple sets 
of 1921, 1921-1/5, and 1921-2 reports, a CCDR 
Report must be validated and generated for 
each data set.  For example, the report names 
could be: “Variant 1” and “Variant 2”.

• Submitters are required to validate SRDRs, 
however, due to the implementation of the new 
SRDR Database, submitters will be able to 
submit even if major errors are identified.

• Submitters are NOT required to validate CWBS 
Dictionaries. When uploading these files, Click 
Next to continue.
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Step 4: Name Data Set & Validate
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

In order to associate your files with a 
data report, make sure you select the 
correct files from the Select Validation 
Options table, Name Data Set then click 
Validate.

All files must be associated 
with a data report and have 
no major errors in order to 
proceed.

A report is Valid if it 
has not been deleted 
or replaced. This 
column is for the use 
of DCARC analysts.
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Step 4: Name Data Set & Validate
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Running a validation error report may take a few minutes to load. Use the         refresh icons to 
update the results.

• NOTE: You may have to refresh the website page or return to a previous tab in order to allow 
the validation error report enough time to finish processing.
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Step 5: Name Data Set & Validate
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• During the validation process, you may need to remove and upload corrected files to 
the submission event. 

• When this occurs, use the drop down menu in the File and Data Report Status table to 
select the correct report name.

• This will trigger the Validation Options table to populate with the newly uploaded files.
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Step 5: Review Major Errors
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The cPet Validation Error Report is displayed on the Validation screen.  
• ALL identified Major errors MUST be corrected in order to proceed to 

the next step in the upload process.

The DCARC POC 
information is 
listed for you to 
contact with 
questions.
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Step 6: Review Minor Errors
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The cPet Validation Error Report also displays Minor errors, or 
errors that require additional comments in the Remarks section.

• Minor errors displayed on the Validation tab will NOT prevent the 
submission from being submitted.
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Step 7: Review Data Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The Submitter should review the cost data under View Report Data to check for missing or incorrect 
data.
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Step 8: Proceed with No Major Errors
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Click Next to proceed to the 
Review and Submit tab.

• Steps 1 – 7 should be repeated until there are no Major errors identified and the Validation Error Report allows 
you to Proceed to the next step, and click Next located at the top of the page.

• If you leave the Submit-Review application, the started submission will be found under Submissions in Progress.
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Step 9: Review and Submit
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Once the 1921, 1921-1/5, and 1921-2 reports 
have been validated with NO MAJOR ERRORS, 
the CCDR Data Report has been generated, and 
the Submitter has reviewed their Data Report, 
click Submit to finalize the submission.

• CWBS Dictionaries reports do not have to be 
validated; therefore, can move from the Upload 
Files tab to the Review & Submit tab.

• SRDR reports must be validated, however, if 
major errors exist submitters will be able to 
move officially submit.

• The Submitter will receive an automatic email
confirmation from the system as soon as their 
reports have been submitted.

1

2

3
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FlexFile Submissions: Steps 1 & 2
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• When submitting FlexFile reports 
follow step 1 and as shown in slides 
34 & 35. 

• When proceeding to step 2, a 
yellow box will appear with 
guidance on the proper file format 
for FlexFile and Quantity 
submissions. 

• Upload the correct FlexFile in a .zip 
format, select the correct File Type, 
and click Next to continue. 
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FlexFile Submission:  Step 3 - Validation 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• In the Validate: Choose Files table, use the FlexFile/Quantity validation section.
• Select the correct files from the Select Validation Options table, then click Validate.
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FlexFile Submission:  Step 3 - Validation 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• When Validating Flexfiles CCDR 
reports will be automatically 
titled according to their 
submission events

• Select Validation Errors to 
download FlexFile Validation 
Results as an excel file

• FF validation errors can viewed 
within the CSDR-SR by 
selecting an individual CCDR 
report and viewing the Major 
and Minor Error Tabs. 
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FlexFile Validation: View Report Data 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The Submitter should review Validation Results to identify and correct any identified Errors 

Downloadable Validation Checklist 
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FlexFile Validation: View Report Data 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

The Submitter should review Validation Results to identify and correct any identified Errors 

CSDR-SR internal Validation Report 
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FlexFile Submission: Proceed With No Major Errors
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The Validation process should be completed until no Major errors are identified and the Validation Error Report 
allows you to Proceed to the next step; click Next located at the top of the page to proceed to the Review & 
Submit Tab

• If you leave the Submit-Review application, the started submission will be found under Submissions in Progress.
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FlexFile Submission: Review & Submit
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Once the 1921-FF report has been validated with 
NO MAJOR ERRORS, the CCDR Data Report has 
been generated, and the Submitter has reviewed 
their Data Report, click Submit to finalize the 
submission.

• CWBS Dictionaries and SRDR reports do not have 
to be validated; therefore, can move from the 
Upload Files tab to the Review & Submit tab.

• The Submitter will receive an automatic email
confirmation from the system as soon as their 
reports have been submitted.

1

2

3



Submitting Software and CWBS 
Dictionaries
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Submitting Software reports and CWBS 
Dictionaries

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

NAME/ADDRESS

PRIME/ASSOCIATE CONTRACTOR

DIRECT-REPORTING SUBCONTRACTOR

GOVERNMENT

CUSTOMER

Department

CERTIFICATION DATE

CONTRACT TYPE

WBS ELEMENT CODE WBS REPORTING ELEMENT

LEAD EVALUATORSOFTWARE PROCESS MATURITY

a. CONTRACT NO.:

b. LATEST MODIFCATION:

PERIOD OF PERFORMANCE

RDT&E

PROCUREMENT

O&M

SUBMISSION NUMBER

RESUBMISSION NUMBER

REPORT AS OF (YYYYMMDD)

DATE PREPARED (YYYYMMDD)

TYPE ACTION
e. TASK ORDER/DELIVERY 

ORDER NO.: 
c. SOLICITATION NO.:

d. NAME:

 UNCLASSIFIED

SECURITY CLASSIFICATION

SRDR DATA DICTIONARY FILENAME 

Section 3.1 REPORT CONTEXT AND DEVELOPMENT ORGANIZATION

Due 60 days after contract award and 60 days after start of any release or build.

COMMENTS

EVALUATOR AFFILIATION

a. START DATE (YYYYMMDD):

b. END DATE (YYYYMMDD):

SOFTWARE RESOURCES DATA REPORTING: INITIAL DEVELOPER REPORT (SAMPLE FORMAT 2)

PRECEDENTS (List up to five similar systems by the same organization or team.)

DEVELOPMENT ORGANIZATION

b. PHASE/MILESTONE:

a. REPORTING ORGANIZATION:

APPROVED PLAN NUMBER

b. DIVISION:

MAJOR PROGRAM a. NAME:

NAME (Last, First, Middle Initial) Telephone (Include Area Code) EMAIL ADDRESS

REPORTING ORGANIZATION TYPE

APPROPRIATION

UPGRADE OR

 NEW?

% % %

% %

Section 3.2 PRODUCT AND DEVELOPMENT DESCRIPTION

Section 3.2.6 PERSONNEL EXPERIENCE IN DOMAIN 

INTEGRATION EFFORT

(OPTIONAL)

Section 3.2.5 STAFFING

PRIMARY

PROGRAMMING

LANGUAGE

PERCENT OF 

PRODUCT 

SIZE

APPLICATION TYPE

SECONDARY

PROGRAMMING

LANGUAGE

SW DEVELOPMENT

METHOD(S)

HOURS/STAFF-MONTHPEAK STAFF DATEPEAK STAFF (Maximum Team Size in FTE )

VERY HIGHLY EXPERIENCED: HIGHLY EXPERIENCED: NOMINALLY EXPERIENCED:

SOFTWARE DEVELOPMENT CHARACTERIZATION

FUNCTIONAL DESCRIPTION

LOW EXPERIENCE: INEXPERIENCED/ENTRY LEVEL:

COMMENTS 

INTEGRATION EFFORT

(OPTIONAL)
NAME

SOFTWARE REUSE

NAME

PLANNED

DEVELOPMENT

PROCESS

Section 3.2.4 COTS/GOTS APPLICATIONS USED:

TOTAL 

HOURS PRIME 

CONTRACTOR 

ONLY

TOTAL HOURS ALL 

OTHER

 SUBCONTRACTORS

Section 3.4.1 (Example: SYSTEM/SOFTWARE QUALIFICATION TESTING)

Total

NUMBER OF DEFECTS REMOVED

Section 3.4.1 (Example: SOFTWARE REQUIREMENTS ANALYSIS)

SOFTWARE ACTIVITY NAME

Section 3.4.1 (Example: SOFTWARE ARCHITECTURE AND DETAILED DESIGN)

Section 3.4.1 (Example: SOFTWARE CODING AND UNIT TESTING)

Section 3.4.1 (Example: SOFTWARE INTEGRATION)

Section 3.4.1 (Example: SOFTWARE QUALIFICATION TESTING)

MAPS TO CSDR 

WBS NUMBER(S)

Section 3.4.1 (Example: SOFTWARE CONFIGURATION MANAGEMENT)

END                       

MONTH

START 

MONTH  

Section 3.1.1  UNCLASSIFIED

SECURITY CLASSIFICATION

Section 3.4 ESTIMATED RESOURCE AND SCHEDULE REPORTING

SOFTWARE RESOURCES DATA REPORTING: INITIAL DEVELOPER REPORT (SAMPLE FORMAT 2)

Section 3.4.1 (Example: SYSTEM/SOFTWARE INTEGRATION)

Section 3.4.1 (Example: SOFTWARE QUALITY ASSURANCE)

SECURITY CLASSIFICATION

Section 3.1.1 UNCLASSIFIED

COMMENTS

COMMENTS NUMBER OF DEFECTS DEFERRED TO POST DEPLOYMENT

NUMBER OF DEFECTS DISCOVERED

Section 3.5 PRODUCT QUALITY REPORTING (OPTIONAL)

TOTAL SOFTWARE DEVELOPMENT EFFORT

ALL OTHER DIRECT SOFTWARE ENGINEERING DEVELOPMENT EFFORT

Section 3.4.1 (Example:  DATA, PROCESS IMPROVEMENT, INDEPENDENT VERIFICATION & 

VALIDATION, PROBLEM RESOLUTION)

Section 3.4.1 (Example: SOFTWARE PROGRAM MANAGEMENT)

• For contracts with a Cost and Software Data 
Reporting (CSDR) requirement, the contractor 
must also supply a Contractor Work Breakdown 
Structure Dictionary detailing the reporting 
elements with definitions of technical, work, 
and cost content.

• Software Resource Data Reports (SRDRs) detail 
the size, schedule and effort on software 
development efforts.

• Both CWBS Dictionaries and SRDRs have a 
different validation process, requiring a more 
manual review.
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Submitting CWBS Dictionaries - Step 1: Select 
Submission Event

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

From your Upload Home page in the CSDR-SR, identify the Submission Event and click 
Upload to begin the submission.
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Submitting CWBS Dictionaries - Step 2: Enter 
the As of Date

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Enter the report As of Date for 
the submission. The report As Of 
Date should be consistent with 
item 14d of the approved CSDR 
Plan.

• Once the POC Information has 
been verified, select Next to 
continue.



71

Submitting CWBS Dictionaries - Step 3: Browse, 
Select, Upload Files

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• To upload files, select 
Browse to locate the 
report, select the 
correct File Type, and 
click Upload.

• Click Next to continue.
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Submitting CWBS Dictionaries - Step 4: Review 
& Submit

CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Submitters are NOT required to validate 
CWBS Dictionaries. 

• CWBS Dictionaries do not have to be validated 
using cPet; therefore, can move from the Upload 
Files tab to the Review & Submit tab.

• The Submitter will receive an automatic email
confirmation from the system as soon as their 
reports have been submitted.

1

2

3
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SRDR Submission: Steps 1&2 
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• When submitting SRDR reports 
follow step 1 and as shown in 
slides 34 & 35 and select next to 
continue onto step 2. 

• Use the “Select Files to Upload” 
box to select the SRDR file, and 
use the “Select File Type” 
dropdown menu to select the 
correct submission event file 
type (SRDR Dev, MX, or ERP)   

• Use the “File Comments” section 
to add any additional desired 
information and select “Next” at 
the top of the page to continue 
to Step 3.

1

2
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SRDR Submission Step 3: Name Data Set and Validate   
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Use the “SRDR Validation” menu at 
the bottom of the page to select the 
correct SRDR File and Contract Plan 
and select the “Validate” button to 
run the validation report.

• Note: The SRDR submission will only 
generate a validation report if your 
SRDR submission is in a XML-compliant 
template  

• XML Compliant SRDR templates 
can be made using cPet desktop; 
for more information consult 
the cPet Desktop user guide

• SRDR reports validation must be run in 
order to be submitted, but they do not 
have to pass validation (for example: if 
the submission is in the May 2018 
SRDR Format) 

https://cade.osd.mil/content/cade/files/csdr/cPet/cPet%20User%20Guide_v2.7.0_20190918.pdf


75

SRDR Submission Step 4: Review & Submit
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

1 • The Submitter will receive an automatic email
confirmation from the system as soon as their 
reports have been submitted.

2

3



Submitting Cost Reports: 1921-3 & FPR 
Data
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The Contractor Business Data Report (1921-3) is the Department of Defense (DoD) system for 
collecting costs and hours at the business unit level in terms of the contractor’s own proposed 
categories.

• To submit a 1921-3 report for your business unit, select 1921-3 &FPR from your Portal Home.
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Select MY FPR from the 1921-3 & FPR 
S-R Home and navigate to the Upload 
Home page in order to view 
submission events.

• Forward Pricing Unit (FPR) is used to 
refer to the business unit.
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Navigate to the New Submission tab. Here you will be able to select 
your FPR unit submission event.

• If you do not see a FPR unit listed, contact the CADE Support Help 
Desk to be assigned to the correct FPR unit.
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Enter the report As of Date for 
the submission. Reports are 
submitted annually, within 60 
days subsequent to the end of 
the contractor’s fiscal year.

• Select 1921-3 as the Report Type.

• Once the POC Information has 
been verified, select Save to 
continue.
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• To upload files, select Browse to locate the report, select the 
correct File Type, and click Upload.

• Click Next to continue.
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Submitters must validate and 
generate a CCDR Data Report prior to 
submitting 1921-3 reports.

• 1921-3 files must be submitted as a 
stand-alone Excel-compatible file or 
as a XML file.

• The XML file can be generated 
automatically from the Excel-
compatible file using the cPet
software tool.

Participants submitting pilot submissions of the 2018 1921-3 form can submit in the contractor’s own format and according 
to the contractor’s own rate structure. Questions about pilot participation and submissions can be sent to the CADE Support 

Help Desk.
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Submitting 1921-3 Reports
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Once the 1921-3 report has been validated, click Submit
to finalize the submission.

• The Submitter will receive an automatic email
confirmation from the system as soon as their reports 
have been submitted.

• A record of your submission will be available for you to 
view in the Submission History tab.

1

2

3



Viewing CSDR Plans
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Viewing CSDR Plans
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• To access the CSDR plans the DCARC has on file for your contracts, you must access the 
Contract Detail Screen for each contract individually.

• You can access the Contract Detail screen by clicking on Contract Number hyperlink on the 
Assigned Contracts tab on the Upload Home page.
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Viewing CSDR Plans
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• Select the Contract Tasks/Plans tab.
• All approved CSDR plans for the contract will be viewable.
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Viewing CSDR Plans
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

Selecting View will allow you to access both the XML and Excel version 
of the CSDR plans that are currently on file.
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Viewing CSDR Plans
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The Excel and XML versions of 
the approved CSDR Plan can 
also be viewed and 
downloaded during Step 3 of 
the  cost report submission 
process.

• Click on the Assigned Plan 
Number to view/download the 
Excel and XML versions of the 
plan.



89

Viewing CSDR Plans
CADE Training

Getting Started / 
Registration

XML Conversion

Submitting Cost 
Reports

Preparing CSDR 
Reports for 
Submission

Viewing CSDR 
Plans 

• The Excel and XML versions of 
the approved CSDR Plan can 
also be viewed and 
downloaded during Step 3 of 
the  cost report submission 
process.

• Click on the Assigned Plan 
Number to view/download the 
Excel and XML versions of the 
plan.


